Modern College Wadi, Nagpur. (VB.NET Notes 5th Sem)
Unit 1 : 2Mark Questions
Q.1) What is .Net Framework?
Ans : The .Net framework is a software development platform developed by Microsoft. The framework was meant
to create applications, which would run on the Windows Platform. The first version of the .Net framework was
released in the year 2002.
Q.2) What is MSIL?
Ans : MSIL stands for Microsoft Intermediate Language. It is Set of Independent instructions that are generated by
language compiler when the project is compiled . MSIL code is not executable but can be processed by CLR before it
becomes executable . MSIL is available in assembly of .net app.
Q.3) What do you mean by executing code?
Ans : Compilation is the process of converting high level code(user understandable code) to low level code(system
or compiler level code). Execution is the process of reading low level code and actually running it.
Q.4) What do you mean by console application?
Ans : A console application is a computer program designed to be used via a text-only computer interface, such as a
text terminal, the command line interface of some operating systems (Unix, DOS, etc.)
Q.5) What is variable?
Ans : It is a name given to storage area and its value change during program execution. It is used to store data, and
its value change at any time.
Q.6) What is module?
Ans : A module is a software component or part of a program that contains one or more routines. One or more
independently developed modules make up a program.
Q.7) What is IDE?
Ans : An integrated development environment (IDE) is a software application that provides comprehensive facilities
to computer programmers for software development. An IDE normally consists of a source code editor, build
automation tools, and a debugger. Most modern IDEs have intelligent code completion.
Q.8) List out the components of visual basic.net IDE?
Ans : a) Toolbox Window b) Solution Explore Window c) class view window d) Server Explorer Window e) Properties
Window f) Object browser Window g) task list windows
Q.9) Define Data Type?
Ans : Data types refer to an extensive system used for declaring variables or functions of different types. The type
of a variable determines how much space it occupies in storage and how the bit pattern stored is interpreted.
Data Types Available in VB.Net
VB.Net provides a wide range of data types.
Q.10) What is comment?
Ans : As you read the code examples, you often encounter the comment symbol ('). This symbol tells the Visual Basic
compiler to ignore the text following it, or the comment. Comments are brief explanatory notes added to code for
the benefit of those reading it.
VB.NET doesn't support for multi line comment. The only way to do multi-line comments in VB.NET is to do a lot of
single line comments( ' ). Or just highlight the whole code and just use (Ctrl+E,C) , (Ctrl+E,U) to comment or
uncomment.
Q.11) What is whitespace?
Ans : Whitespace characters, characters in computing that represent horizontal or vertical space;
Q.12) What do you mean by interation?
Ans : Interaction is a kind of action that occur as two or more objects have an effect upon one another. The idea of
a two-way effect is essential in the concept of interaction, as opposed to a one-way causal effect.
Q.13) What are control flow statement?
Ans : The statements inside your source files are generally executed from top to bottom, in the order that they
appear. Control flow statements, however, break up the flow of execution by employing decision making, looping,
and branching, enabling your program to conditionally execute particular blocks of code.
Q.14) What do you mean by operator?
Ans : An operator is a symbol that tells the compiler to perform specific mathematical or logical manipulations.
VB.Net is rich in built-in operators and provides following types of commonly used operators − Arithmetic Operators.
Comparison Operators.
Q.15) What is method?
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Ans : A method in object-oriented programming is a procedure associated with a message and an object. An object
is mostly made up of data and behavior, which form the interface that an object presents to the outside world. Data
is represented as properties of the object and behavior as methods.
3 Marks Question
Q.1 ) What is the purpose of common Language specification?
Ans : CLS is a part of the specifications of the .NET Framework. CLS was designed to support language constructs
commonly used by developers and to produce verifiable code, which allows all CLS-compliant languages to ensure
the type safety of code. CLS includes features common to many object-oriented programming languages.
Q.2) What is common type system?
Ans : .NET Framework, the Common Type System (CTS) is a standard that specifies how type definitions and specific
values of types are represented in computer memory. It is intended to allow programs written in different
programming languages to easily share information.
Q.3) What is common Language Runtime?
Ans : The Common Language Runtime (CLR), the virtual machine component of Microsoft's .NET framework,
manages the execution of .NET programs. A process known as just-in-time compilation converts compiled code into
machine instructions which the computer's CPU then executes.
Q.4) What are the advantage of VB.Net?
Ans : The structure of the Basic programming language is very simple, particularly as to the executable code. VB is
not only a language but primarily an integrated, interactive development environment (“IDE“). The VB-IDE has been
highly optimized to support rapid application development (“RAD”).
Q. 5) Write down the steps to install VB.Net.
Ans :

Q.6) Differentiate Single-Precision, floating point numbers with double – floating point numbers with example.
Ans :

Q. 7) What is select – Case statement? Give an example.
Ans : A Select Case statement allows a variable to be tested for equality against a list of values. Each value is called a
case, and the variable being switched on is checked for each select case.
Example :
Module decisions
Sub Main()
'local variable definition
Dim grade As Char
grade = "B"
Select grade
Case "A"
Console.WriteLine("Excellent!")
Case "B", "C"
Console.WriteLine("Well done")
Case "D"
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Console.WriteLine("You passed")
Case "F"
Console.WriteLine("Better try again")
Case Else
Console.WriteLine("Invalid grade")
End Select
Console.WriteLine("Your grade is {0}", grade)
Console.ReadLine()
End Sub
End Module
Q. 8) What do you mean by case Else statement ? Give an example.
Ans : One or more statements following Case Else that run if testexpression does not match any clause in the
expressionlist of any of the Case statements.
Q. 9) How to declare a method? Give its system and example.
Ans :

Q. 10) Write down the syntax and example of if statement in VB.net.
Ans : Syntax :
If condition Then
[Statement(s)]
End If
Example :
If (a <= 20) Then
c= c+1
End If
Q.11) Give an example of single line if statement ?
Ans : If the condition evaluates to true, then the block of code inside the If statement will be executed. If condition
evaluates to false, then the first set of code after the end of the If statement (after the closing End If) will be executed
If (a <= 20) Then
c= c+1
End If
Q. 12) Write down the syntax and example of do-loop in VB.net
Ans : : Do
[ statements ]
[ Continue Do ]
[ statements ]
[ Exit Do ]
[ statements ]
Loop { While | Until } condition
Example
Module loops
Sub Main()
' local variable definition
Dim a As Integer = 10
'do loop execution
Do
Console.WriteLine("value of a: {0}", a)
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a=a+1
Loop While (a < 20)
Console.ReadLine()
End Sub
End Module
Q. 13) Write down the syntax and example of do unit loop in VB. Net
Ans : syntax : Do { While | Until } condition
[ statements ]
[ Continue Do ]
[ statements ]
[ Exit Do ]
[ statements ]
Loop
Example :
Module loops
Sub Main()
' local variable definition
Dim a As Integer = 10
'do loop execution
Do
Console.WriteLine("value of a: {0}", a)
a=a+1
Loop Until (a = 20)
Console.ReadLine()
End Sub
End Module
Q. 14) What do you mean by nested loop?
Ans : On loop nesting is that you can put any type of loop inside of any other type of loop. For example, a for loop
can be inside a while loop or vice versa.
Example
The following program uses a nested for loop to find the prime numbers from 2 to 100 −
Live Demo
Module loops
Sub Main()
' local variable definition
Dim i, j As Integer
For i = 2 To 100
For j = 2 To i
' if factor found, not prime
If ((i Mod j) = 0) Then
Exit For
End If
Next j
If (j > (i \ j)) Then
Console.WriteLine("{0} is prime", i)
End If
Next i
Console.ReadLine()
End Sub
End Module
Q. 15) Give an example of infinite loop?
Ans :
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Dim i As Integer = 0
While i < 1
Console.WriteLine("Infinite Loop")
i += 1
i -= 1
End While
5 Marks Question in Unit 1
Q.1) Explain .Net framework classes in details.
Ans :
A class definition starts with the keyword Class followed by the class name; and the class body,
ended by the End Class statement. Following is the general form of a class definition:
[ <attributelist> ] [ accessmodifier ] [ Shadows ] [ MustInherit | NotInheritable ] [
Partial ] _
Class name [ ( Of typelist ) ]
[ Inherits classname ]
[ Implements interfacenames ]
[ statements ]
End Class
Where,
attributelist is a list of attributes that apply to the class. Optional.
accessmodifier defines the access levels of the class, it has values as - Public, Protected,
Friend, Protected Friend and Private. Optional.
Shadows indicate that the variable re-declares and hides an identically named element, or
set of overloaded elements, in a base class. Optional.
MustInherit specifies that the class can be used only as a base class and that you cannot
create an object directly from it, i.e., an abstract class. Optional.
NotInheritable specifies that the class cannot be used as a base class.
Partial indicates a partial definition of the class.
Inherits specifies the base class it is inheriting from.
Implements specifies the interfaces the class is inheriting from
Q.2) How to execute an application in VB.Net? Explain
Ans : Process
Step 1 : Create a application in VB.Net on two ways
1) Console base Application and
2) Window Base Application
Step 2 : Create a window base application click on file menu
Step 3: click on new option → go to project → Open a new project dialog box → select windows application form
Step 4 : Design a form using toolbox control.
Step 5 : write a code in coding windows
Step 6 : Click on debug menu
Step 7 : Click on start debugging option.
Or
Press F5
Q.3) Write a note on common language runtime.
Ans : The Common Language Runtime (CLR), the virtual machine component of Microsoft's .NET framework,
manages the execution of .NET programs. A process known as just-in-time compilation converts compiled code into
machine instructions which the computer's CPU then executes. The CLR provides additional services including
memory management, type safety, exception handling, garbage collection, security and thread management. All
programs written for the .NET framework, regardless of programming language, are executed by the CLR. All
versions of the .NET framework include CLR. The CLR team was started June 13, 1998.
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CLR implements the Virtual Execution System (VES) as defined in the Common Language Infrastructure (CLI)
standard, initially developed by Microsoft itself. A public standard defines the Common Language Infrastructure
specification.
Q.4) Explain various data types supported by VB.Net
Ans : Data types refer to an extensive system used for declaring variables or functions of different types. The type
of a variable determines how much space it occupies in storage and how the bit pattern stored is interpreted.
Data Types Available in VB.Net
VB.Net provides a wide range of data types. The following table shows all the data types available:
Data Type
Storage Allocation
Value Range
Q.5) Why use methods? Explain with an example
Ans :

Q.6) Explain if - else statement with example.
Ans : An If statement can be followed by an optional Else statement, which executes when the Boolean expression
is false.
Syntax
The syntax of an If...Then... Else statement in VB.Net is as follows −
If(boolean_expression)Then
'statement(s) will execute if the Boolean expression is true
Else
'statement(s) will execute if the Boolean expression is false
End If
If the Boolean expression evaluates to true, then the if block of code will be executed, otherwise else block of code
will be executed.
Example
Module decisions
Sub Main()
'local variable definition '
Dim a As Integer = 100
' check the boolean condition using if statement
If (a < 20) Then
' if condition is true then print the following
Console.WriteLine("a is less than 20")
Else
' if condition is false then print the following
Console.WriteLine("a is not less than 20")
End If
Console.WriteLine("value of a is : {0}", a)
Console.ReadLine()
End Sub
End Module
Q.7) Explain nested if statement with example.
Ans : It is always legal in VB.Net to nest If-Then-Else statements, which means you can use one If or ElseIf statement
inside another If ElseIf statement(s).
Syntax
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The syntax for a nested If statement is as follows −
If( boolean_expression 1)Then
'Executes when the boolean expression 1 is true
If(boolean_expression 2)Then
'Executes when the boolean expression 2 is true
End If
End If
You can nest ElseIf...Else in the similar way as you have nested If statement.
Example
Module decisions
Sub Main()
'local variable definition
Dim a As Integer = 100
Dim b As Integer = 200
' check the boolean condition
If (a = 100) Then
' if condition is true then check the following
If (b = 200) Then
' if condition is true then print the following
Console.WriteLine("Value of a is 100 and b is 200")
End If
End If
Console.WriteLine("Exact value of a is : {0}", a)
Console.WriteLine("Exact value of b is : {0}", b)
Console.ReadLine()
End Sub
End Module
Q.8) Explain for …. Next loop with its syntax and example.
Ans : It repeats a group of statements a specified number of times and a loop index counts the number of loop
iterations as the loop executes.
The syntax for this loop construct is −
For counter [ As datatype ] = start To end [ Step step ]
[ statements ]
[ Continue For ]
[ statements ]
[ Exit For ]
[ statements ]
Next [ counter ]
Example
Module loops
Sub Main()
Dim a As Byte
' for loop execution
For a = 10 To 20
Console.WriteLine("value of a: {0}", a)
Next
Console.ReadLine()
End Sub
End Module
Q.9) Explain for each.. next loop with its syntax and example.
Ans : It repeats a group of statements for each element in a collection. This loop is used for accessing and
manipulating all elements in an array or a VB.Net collection.
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The syntax for this loop construct is −
For Each element [ As datatype ] In group
[ statements ]
[ Continue For ]
[ statements ]
[ Exit For ]
[ statements ]
Next [ element ]
Example
Module loops
Sub Main()
Dim anArray() As Integer = {1, 3, 5, 7, 9}
Dim arrayItem As Integer
'displaying the values
For Each arrayItem In anArray
Console.WriteLine(arrayItem)
Next
Console.ReadLine()
End Sub
End Module
Q. 10) Explain while…. End while loop with its syntax and example.
Ans : It executes a series of statements as long as a given condition is True.
The syntax for this loop construct is −
While condition
[ statements ]
[ Continue While ]
[ statements ]
[ Exit While ]
[ statements ]
End While
Here, statement(s) may be a single statement or a block of statements. The condition may be any expression, and
true is logical true. The loop iterates while the condition is true.
When the condition becomes false, program control passes to the line immediately following the loop.
Here, key point of the While loop is that the loop might not ever run. When the condition is tested and the result is
false, the loop body will be skipped and the first statement after the while loop will be executed.
Example
Module loops
Sub Main()
Dim a As Integer = 10
' while loop execution '
While a < 20
Console.WriteLine("value of a: {0}", a)
a=a+1
End While
Console.ReadLine()
End Sub
End Module
Unit II
1)What is an array?
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Ans:-Array is a collection of having some name and same data type with unique index number . In same data type
and store in consecutive memory allocation.
2) How to declare an array in vb.net?
Ans:- To declare an array in VB.Net, you use the Dim statement. For example,
Dim intdata(30)
Dim twodarray(10,20)
3) What is enumeration?
Ans:-When you are in a situation to have a number of constants that are logically related to each other, you can
define them together these constants in an enumerator list. An enumerated type is declared using the enum
keyword.
4) What is structure?
Ans:-In addition to fields, structures can expose properties, methods, and events. A structure can implement one or
more interfaces, and you can declare individual access levels for each field.
5) What is collection?
Ans:-The Collection Object. VB.NET implements a special object called the Collection object that acts as a container
for objects of all types. In fact, Collection objects can hold other objects, as well as nonobject data. In some ways,
the Collection object is an object-oriented version of the Visual Basic array.
6)What do you mean by array list?
Ans:-It represents an ordered collection of an object that can be indexed individually. It is basically an alternative to
an array. However, unlike array, you can add and remove items from a list at a specified position using an index and
the array resizes itself automatically.
7) What is event?
Ans:-An event is a signal that informs an application that something important has occurred. For example, when a
user clicks a control on a form, the form can raise a Click event and call a procedure that handles the event. Events
also allow separate tasks to communicate.
8) What is form?
Ans:-Visual Basic Form is the container for all the controls that make up the user interface. Every window you see in
a running visual basic application is a form, thus the terms form and window describe the same entity. Visual Studio
creates a default form for you when you create a Windows Forms Application.
9) What is use of property windows?
Ans:-Property window is the collective name for the following types of user interfaces (UIs): Property sheet: used to
view and change properties for an object or collection of objects in a dialog box. Property inspector: used to view
and change properties for an object or collection of objects in a pane.
10) What is the use of label control?
Ans:-Windows Forms Label controls are used to display text or images that cannot be edited by the user. They are
used to identify objects on a form—to provide a description of what a certain control will do if clicked, for example,
or to display information in response to a run-time event or process in your application.
11) What is the use of button control?
Ans:-Button class in Windows Forms represents a Button control. A Button control is a child control placed on a
Form and used to process click event and can be clicked by a mouse click or by pressing ENTER or ESC keys.
12) Difference between check box and radio button?
Ans:-There is a fundamental difference between them. In a checkbox group, a user can select more than one
option. Each checkbox operates individually, so a user can toggle each response "on" and "off." Radio buttons,
however, operate as a group and provide mutually exclusive selection values.
13) What is the use of color dialogue box?
Ans:-The ColorDialog control class represents a common dialog box that displays available colors along with
controls that enable the user to define custom colors. It lets the user select a color.
14) what is the use of solution Explorer window?
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Ans:-The Solution Explorer Window. Solution Explorer is a special window that enables you to manage solutions,
projects, and files. It provides a complete view of the files in a project, and it enables you to add or remove files
and to organize files into subfolders.
15) what is the use of save dialogue box?
Ans:-The SaveFileDialog control prompts the user to select a location for saving a file and allows the user to specify
the name of the file to save data. The SaveFileDialog control class inherits from the abstract class FileDialog.
Unit II( 3marks)
1) how to declare an array?Give an example.
Ans:-To declare an array in VB.Net, you use the Dim statement. For example,
Dim intData(30) ' an array of 31 elements
Dim strData(20) As String
' an array of 21 strings
Dim twoDarray(10, 20) As Integer
'a two dimensional array of integers
Dim ranges(10, 100)
'a two dimensional array
Example:-Dim intData() As Integer = {12, 16, 20, 24, 28, 32}
Dim names() As String = {"Karthik", "Sandhya", _
"Shivangi", "Ashwitha", "Somnath"}
Dim Arr() As Object = {"Hello World", 12d, 16ui, "A"c}
2) What do you mean by Redim keywords in vb.net?
1. Ans:-ReDim is the keyword that denotes we are redimensioning an array.
2. Preserve is an optional keyword that forces Visual Basic to retain all existing elements' values. ...
3. ArrayName is the name of the array.
4. Subscript is the dimensions of the array.
5. DataType is any valid data type.
3)What do you mean by constant? Give an example.
Ans:-Constants and Enumerations. ... There are also enumeration constants as well. The constants are treated just
like regular variables except that their values cannot be modified after their definition. An enumeration is a set of
named integer constants.
Module constantsNenum
Sub Main()
Const PI = 3.14149
Dim radius, area As Single
radius = 7
area = PI * radius * rad mcArea = " & Str(area))
Console.ReadKey()
End Sub
End Module
4) how to structure define in VB.net ?given an example.
1) Ans:-A user defined data type .They are user-defined and provide a method for packing together data of
different types.
2) Use structure keyword to declare the structure.
3) It is value type and store on Stack.
4) Cannot have explicit default constructor but can have parameterized constructors.
5) Cannot have destructor.
5) write down any three control in VB.net?
And:-1)The Label
This is probably the first control you will master. It is used to display static text, titles and screen output from
operations.
2)The Form
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We covered it too briefly in Lesson 01 so we'll go over it again. The Form is the first object you see when you Open
the application. It's the window into which all the controls will appear, where you will input data and see results.
3)Frame & PictureBox
When you want to group several controls together - name and address, for example - you use a Frame. The frame
backcolor can be the same as the form's and only the frame borders will be obvious, or it can be a different color
and stand out.
6)Write down the purpose of any three events in VB.net?
Ans:7) what is single document interface?
Ans:-A multiple document interface (MDI) is a graphical user interface in which multiple windows reside under a
single parent window. Such systems often allow child windows to embed other windows inside them as well,
creating complex nested hierarchies
8) what is multiple document interface?
And:-MDI (Multiple Document Interface) is a Microsoft Windows programming interface for creating an application
that enables users to work with multiple documents at the same time. ... An MDI application is something like the
Windows desktop interface since both include multiple viewing spaces.
9) what are ennumeration?
Ans:-When you are in a situation to have a number of constants that are logically related to each other, you can
define them together these constants in an enumerator list. An enumerated type is declared using the enum
keyword.
10 )what is Hash table?
Ans:-A hash table is used when you need to access elements by using key, and you can identify a useful key value.
Each item in the hash table has a key/value pair. The key is used to access the items in the collection.
11) what is lookup table?
Ans:-A lookup table is a table of data that has a column that displays data from records in a related table. In the
following procedures, a Combo Box control is used to display the field with the foreign-key relationship from the
parent to the child table. ... But to save space, the table leaves out data that adds clarity.
12) write any three properties of form control?
Ans:-1)Name:-This is the actual name of the form.
2)Text:-The text, which will appear at the title bar of the form.
3)Enabled:-If True, allows the form to respond to mouse and keyboard events; if False, disables form.
13) what is the use of dialogue box?
Ans:-The ColorDialog control class represents a common dialog box that displays available colors along with
controls that enable the user to define custom colors. It lets the user select a color.
14) what is the use of solution Explorer window?
Ans:-The Solution Explorer Window. Solution Explorer is a special window that enables you to manage solutions,
projects, and files. It provides a complete view of the files in a project, and it enables you to add or remove files
and to organize files into subfolders.
15 )what is the use of saving dialogue box?
Ans:-The SaveFileDialog control prompts the user to select a location for saving a file and allows the user to specify
the name of the file to save data. The SaveFileDialog control class inherits from the abstract class FileDialog.
Unit II (5marks)
1) write notes on passing array as parameters?
Ans:2) what is enumeration ?explain with example.
Ans:-An enumerated type is declared using the Enum statement. The Enum statement declares an enumeration
and defines the values of its members. The Enum statement can be used at the module, class, structure,
procedure, or block level.
Example:Module constantsNenum
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Enum Colors
red = 1
orange = 2
yellow = 3
green = 4
azure = 5
blue = 6
violet = 7
End Enum
Sub Main()
Console.WriteLine("The Color Red is : " & Colors.red)
Console.WriteLine("The Color Yellow is : " & Colors.yellow)
Console.WriteLine("The Color Blue is : " & Colors.blue)
Console.WriteLine("The Color Green is : " & Colors.green)
Console.ReadKey()
End Sub
End Module
3) what is the structure ?explain with example.
Ans:-A Structure is a value type. Its data, its meaning, is found directly in its bytes. Integers, Booleans and
DateTimes are built-in Structures.
Example:Structure Simple
Public _position As Integer
Public _exists As Boolean
Public _lastValue As Double
End Structure
Module Module1
Sub Main()
Dim s As Simple
s._position = 1
s._exists = False
s._lastValue = 5.5
Console.WriteLine(s._position)
End Sub
End Module
4) what is constant explain ? Explain various constant with example in VB.net?
Ans:-The constants refer to fixed values that the program may not alter during its execution. These fixed values are
also called literals. Constants can be of any of the basic data types like an integer constant, a floating constant, a
character constant, or a string literal.Constants can be of any of the basic data types like an integer constant, a
floating constant, a character constant, or a string literal.
Example:Class A
Public Const X As Integer = 1, Y As Integer = 2, Z As Integer = 3
End Class
Class B
Public Const X As Integer = 1
Public Const Y As Integer = 2
Public Const Z As Integer = 3
End Class
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5 )Explain arraylist with an example in VB.net?
Ans:-It represents an ordered collection of an object that can be indexed individually. It is basically an alternative to
an array. However, unlike array, you can add and remove items from a list at a specified position using an index and
the array resizes itself automatically. It also allows dynamic memory allocation, adding, searching and sorting items
in the list.
Example:-Module Module1
Sub Main()
' Create a new ArrayList.
' ... Then add three strings to it.
Dim list As New ArrayList
list.Add("One")
list.Add("Two")
list.Add("Three")
End Sub
End Module
6) what do you mean by dynamic array ?explain with suitable example?
Ans:-Dynamic arrays are arrays that can be dimensioned and re-dimensioned as par the need of the program. You
can declare a dynamic array using the ReDim statement. ... The Preserve keyword helps to preserve the data in an
existing array, when you resize it.
Example:Module Module1
Sub Main()
Dim a() As Integer = {2, 2}
Dim i, j As Integer
Console.WriteLine("Array before Redim")
For i = 0 To a.GetUpperBound(0)
Console.WriteLine(a(i))
Next
ReDim Preserve a(5)
Console.WriteLine("Array after Redim")
For j = 0 To a.GetUpperBound(0)
Console.WriteLine(a(j))
Next
Console.ReadLine()
End Sub
End Module
7) write down the step to build a simple window application in VB.net
1. Ans:-On the menu bar, choose File > New > Project. The dialog box should look like this.
2. Choose either Visual C# or Visual Basic in the Installed Templates list.
3. c In the templates list, choose the Windows Forms Application icon. Name the new form PictureViewer,
and then choose the OK button.
4. Visual Studio creates a solution for your program. A solution acts as a container for all of the projects and
files needed by your program. These terms will be explained in more detail later in this tutorial.
5. d) The following illustration shows what you should now see in the Visual Studio interface.
6. The interface contains three windows: a main window, Solution Explorer, and the Properties window.
7. If any of these windows are missing, restore the default window layout by, on the menu bar, choosing
Window > Reset Window Layout. You can also display windows by using menu commands. On the menu
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bar, choose View > Properties Window or Solution Explorer. If any other windows are open, close them by
choosing the Close (x) button in their upper-right corners.
8. The illustration shows the following windows (going clockwise from the upper-left corner):
9. Main window In this window, you'll do most of your work, such as working with forms and editing code. In
the illustration, the window shows a form in the Form Editor. At the top of the window, the Start Page tab
and the Form1.cs [Design] tab appear. (In Visual Basic, the tab name ends with .vb instead of .cs.)
10. Solution Explorer window In this window, you can view and navigate to all items in your solution. If you
choose a file, the contents of the Properties window changes. If you open a code file (which ends in .cs in
Visual C# and .vb in Visual Basic), the code file or a designer for the code file appears. A designer is a visual
surface onto which you can add controls such as buttons and lists. For Visual Studio forms, the designer is
called the Windows Forms Designer.
11. Properties window In this window, you can change the properties of items that you choose in the other
windows. For example, if you choose Form1, you can change its title by setting the Text property, and you
can change the background color by setting the Backcolor property.
12. On the menu bar, choose File > Save All.
13. As an alternative, choose the Save All button on the toolbar, which the following illustration shows.
14. Save All toolbar button Save All toolbar button
15. Visual Studio automatically fills in the folder name and the project name and then saves the project in your
projects folder.
8) explain the properties and methods of fontdialoguebox control?
Ans:- property:1.ShowColor:-Gets or sets a value indicating whether the dialog box displays the color choice.
2.ShowEffects:-Gets or sets a value indicating whether the dialog box contains controls that allow the user to
specify strikethrough, underline, and text color options.
3.Color:-Gets or sets the selected font color.
4.MaxSize:-Gets or sets the maximum point size a user can select.
Methods:1.Apply:-Occurs when the Apply button on the font dialog box is clicked.
9) explain the property and method of open dialogue box control?
Property:1.FileName:-Gets or sets a string containing the file name selected in the file dialog box.
2.Filter:-Gets or sets the current file name filter string, which determines the choices that appear in the "Save as
file type" or "Files of type" box in the dialog box.
3.FilterIndex:-Gets or sets the index of the filter currently selected in the file dialog box.
4.Title:-Gets or sets the file dialog box title.
Method:1.OpenFile:-Opens the file selected by the user, with read-only permission. The file is specified by the FileName
property.
2.Reset:-Resets all options to their default value.
10) explain the property and method of print dialogue box control?
Ans:-Property:1.Document:-Gets or sets a value indicating the PrintDocument used to obtain PrinterSettings
2.PrinterSettings:-Gets or sets the printer settings the dialog box modifies.
3.PrintToFile:-Gets or sets a value indicating whether the Print to file check box is selected.
4.ShowHelp:-Gets or sets a value indicating whether the Help button is displayed.
Method:1.Reset:-Resets all options to their default values.
2.RunDialog:-When overridden in a derived class, specifies a common dialog box.
3.ShowDialog:-Runs a common dialog box with a default owner.
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Unit II ( 10 marks)
1. what is structure ?write it Syntax and example differentiate structure and array in VB.net.
Ans:-A structure is a generalization of the user-defined type (UDT) supported by previous versions of Visual Basic.
In addition to fields, structures can expose properties, methods, and events. A structure can implement one or
more interfaces, and you can declare individual access levels for each field.
Syntax:-Structure MyStruct
Public strName As String
Public strAddr As String
Public blnReg As Boolean
End Structure
Example:-Structure Simple
Public _position As Integer
Public _exists As Boolean
Public _lastValue As Double
End Structure
Module Module1
Sub Main()
Dim s As Simple
s._position = 1
s._exists = False
s._lastValue = 5.5
Console.WriteLine(s._position)
End Sub
End Module
Basic for comparison
Basic
Syntax

Array
An array is a collection of
variables of same data type.
type array_name[size];

Memory

Array elements are stored in
contiguous memory location.

Access

Array elements are accessed by
their index number.
Array declaration and element
accessing operator is "[ ]" (square
bracket).
Objects (instances) of an array
can not be created.

Operator

Object

Size
Bit fiel
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Every element in array is of same
size.
Bit filed can not be defined in an
array.

Structure
A structure is a collection of
variables of different data type.
struct sruct_name{
type element1;
type element1;
.
.
} variable1, variable2, . .;
Structure elements may not be
stored in a contiguous memory
location.
Structure elements are accessed
by their names.
Structure element accessing
operator is "." (Dot operator).
Structure objects (instance or
structure variable) can be
created.
Every element in a structure is of
different data type.
Bit field can be defined in a
structure.
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2) explain dynamic array and arraylist with suitable example?
Ans:-Dynamic array:-Visual Basic Dynamic Array Introduction. A dynamic array is an array that changes size while
the program is running. Unlike the static array in the example above, dynamic arrays do not specify their size when
they are declared.Home>>Tutorials>>Vbnet>>VB Arrays>> Dynamic Array In VB.NET Dynamic arrays are array that
are declared using a Dim statement with blank parenthesis initially and are dynamically allocated dimensions using
the Redim statement.
Example:
Module Module1
Sub Main()
Dim a() As Integer = {2, 2}
Dim i, j As Integer
Console.WriteLine("Array before Redim")
For i = 0 To a.GetUpperBound(0)
Console.WriteLine(a(i))
Next
ReDim Preserve a(5)
Console.WriteLine("Array after Redim")
For j = 0 To a.GetUpperBound(0)
Console.WriteLine(a(j))
Next
Console.ReadLine()
End Sub
End Module
Arraylist:-This collection is a dynamic array. It resizes to fit new elements. An array type offers superior
performance. But the ArrayList is sized automatically by built-in code.
Example:-Module Module1
Sub Main()
' Create a new ArrayList.
' ... Then add three strings to it.
Dim list As New ArrayList
list.Add("One")
list.Add("Two")
list.Add("Three")
End Sub
End Module
4) explain message box and dialogue box in detail?
Ans:-Dialogue box:-There are many built-in dialog boxes to be used in Windows forms for various tasks like opening
and saving files, printing a page, providing choices for colors, fonts, page setup, etc., to the user of an application.
These built-in dialog boxes reduce the developer's time and workload.
All of these dialog box control classes inherit from the CommonDialog class and override the RunDialog() function
of the base class to create the specific dialog box.The RunDialog() function is automatically invoked when a user of
a dialog box calls its ShowDialog() function.
message box:-The Message Box. A message box is a special dialog box used to display a piece of information to the
user. As opposed to a regular form, the user cannot type anything in the dialog box. To support message boxes, the
Visual Basic language provides a function named MsgBox.
5) How to build lookup tables with hastables in vb.net? Explain.
Ans:- Hashtable performs fast lookups from any key. It returns a previously specified value. Conceptually we add
keys and values together. We then search the table instantly or remove elements. The Hashtable is an optimized
lookup mechanism.
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Example. To start, this example shows how to allocate a new Hashtable upon the managed heap. It then adds three
key-value pairs to the data structure. The integer 1 is associated with the string literal "One", for example. Integer
Finally: We use the DictionaryEntry type on the iteration variable and then access the Key and Value properties in
the loop body.
6)Write down the steps to create and clear the edit box in vb.net?
Ans:- Create : Text box controls allow entering text on a form at runtime. By default, it takes a single line of text,
however, you can make it accept multiple texts and even add scroll bars to it.
Let's create a text box by dragging a Text Box control from the Toolbox and dropping it on the form.
Clear :
7) Explain the property and method of following.
Ans:-a) Font dialogue box control:- It prompts the user to choose a font from among those installed on the local
computer and lets the user select the font, font size, and color. It returns the Font and Color objects.
1.Color:-Gets or sets the selected font color.
2.MaxSize:-Gets or sets the maximum point size a user can select.
3.MinSize:-Gets or sets the minimum point size a user can select.
4.ShowColor:-Gets or sets a value indicating whether the dialog box displays the color choice.
5.ShowEffects:-Gets or sets a value indicating whether the dialog box contains controls that allow the user to
specify strikethrough, underline, and text color options.
Method:-1.Reset:-Resets all options to their default values.
2.RunDialog:-When overridden in a derived class, specifies a common dialog box.
3.ShowDialog:-Runs a common dialog box with a default owner.
b) paint dialogue box control:-The ColorDialog control class represents a common dialog box that displays available
colors along with controls that enable the user to define custom colors. It lets the user select a color.The main
property of the ColorDialog control is Color, which returns a Color object.
Property:1.AllowFullOpen:-Gets or sets a value indicating whether the user can use the dialog box to define custom colors.
2.AnyColor:-Gets or sets a value indicating whether the dialog box displays all available colors in the set of basic
colors.
3.CanRaiseEvents:Gets a value indicating whether the component can raise an event.
4.Color:-Gets or sets the color selected by the user.
Method:-1. Reset:-Resets all options to their default values, the last selected color to black, and the custom colors
to their default values.
2.RunDialog:-When overridden in a derived class, specifies a common dialog box.
3.ShowDialog:-Runs a common dialog box with a default owner.
8)Explain the property and method of following:Ans:-1.Open dialogue box control:-The OpenFileDialog control prompts the user to open a file and allows the user
to select a file to open. The user can check if the file exists and then open it. The OpenFileDialog control class
inherits from the abstract class FileDialog.
Property:1.AddExtension:-Gets or sets a value indicating whether the dialog box automatically adds an extension to a file
name if the user omits the extension.
2.AutoUpgradeEnabled:-Gets or sets a value indicating whether this FileDialog instance should automatically
upgrade appearance and behavior when running on Windows Vista.
3:-CheckFileExists:-Gets or sets a value indicating whether the dialog box displays a warning if the user specifies a
file name that does not exist.
4.CheckPathExists:-Gets or sets a value indicating whether the dialog box displays a warning if the user specifies a
path that does not exist.
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Method:1.OpenFile:-Opens the file selected by the user, with read-only permission. The file is specified by the FileName
property.
2.Reset:-Resets all options to their default value.
2)Save dialogue box control:-Run your programme, then click your File > Save menu item. You should see the Save
As dialogue box appear. However, just like the Open box, when you click the Save button no file is actually being
saved. You have to write your own code for this.
Property:1.Title:-Gets or sets the file dialog box title.
2.ValidateNames:-Gets or sets a value indicating whether the dialog box accepts only valid Win32 file names
3.FileNames:-Gets the file names of all selected files in the dialog box.
4.Filter:-Gets or sets the current file name filter string, which determines the choices that appear in the "Save as file
type" or "Files of type" box in the dialog box.
Method:1.OpenFile:-Opens the file with read/write permission.
2.Reset:-Resets all dialog box options to their default values.

Part - A (Each question carries Two marks) UNIT – III
Q.1) Define menu.
Ans : A menu is located on the menu bar and contains a list of related commands. MainMenu is the container
for the Menu structure of the form and menus are made of MenuItem objects that represent individual parts of
a menu.
You can create a main menu object on your form using the MainMenu control. The following picture shows how
to drag the Menustrip Object to the Form
Q.2) Write any three features of menu.
Ans: : 1)The MenuStrip control represents the container for the menu structure.
2)The MenuStrip control works as the top-level container for the menu structure.
3) The ToolStripMenuItem class and the ToolStripDropDownMenu class provide the functionalities to create
menu items, sub menus and drop-down menus.
Q.3) What are context menus?
Ans: The Context Menu Strip control represents a shortcut menu that pops up over controls, usually when you
right click them. They appear in context of some specific controls, so are called context menus. For example,
Cut, Copy or Paste options.
Q.4) What do you mean by debugging?
Ans: Debugging is the routine process of locating and removing computer program bugs, errors or
abnormalities, which is methodically handled by software programmers via debugging tools. Debugging checks,
detects and corrects errors or bugs to allow proper program operation according to set specifications.
Debugging is also known as debug
Q.5) Define syntax error. Give an example.
Ans: A syntax error in computer science is an error in the syntax of a coding or programming language, entered
by a programmer. Syntax errors are caught by a software program called a compiler, and the programmer must
fix them before the program is compiled and then run.
pg. 18

Modern College Wadi, Nagpur. (VB.NET Notes 5th Sem)
Example :
System.out.printIn(“Hello World”);
Q.6) What do you mean by exception?
Ans: An exception is a problem that arises during the execution of a program. An exception is a response to an
exceptional circumstance that arises while a program is running, such as an attempt to divide by zero.
Q.7) Write the syntax of try – catch block of VB.Net.
Ans: Syntax :
Try
[ tryStatements ]
[ Exit Try ]
[ Catch [ exception [ As type ] ] [ When expression ]
[ catchStatements ]
[ Exit Try ] ]
[ Catch ... ]
End Try
Q.9) What is object oriented programming?
Ans: VB.NET is completely object oriented. This article uncovers some basic Object Oriented Programming
features of Visual Basic. NET. The whole article is divided into ten lessons. The source code for these lessons is
provided with the article. To explain the following concepts in an easy and simple way:
• Creating and using classes and objects in VB.NET.
• Encapsulation, Abstraction, Inheritance and Polymorphism.
• Overloading and Overriding.
• Constructors and Destructors.
• Static functions.
Q.10) What is class?
Ans: Classes are the heart and soul of an object-oriented language. You will find yourself using classes
whenever you write even the simplest of programs in Visual Basic .NET. The Microsoft .NET Framework makes
extensive use of classes, and so should you. Below are some common uses of classes:
Q.11) What is object?
Ans: In Object Oriented terms, an Object is a software unit of variables (properties) and methods (functions).
These objects are often used to model the real-world objects that you find in everyday life. An Object's method
provide the only way to access the data. So that the data is hidden and secure from the accidental alteration.
An Object's data and methods encapsulated into a single entity. These (Data Encapsulation and Data hiding)
are the key term used for describing an Object Oriented Language.
Q.12) Define Constructor.
Ans: A Constructor is a special kinds of member function that used to initialize the object.
A constructor is like a method in that it contain executable code and may be defined with parameter.This
is first method that is run when an instance of type is created. constructor is two types in VB.NET
Q.13) Define Inheritance.
Ans: Inheritance is a fundamental feature of an Object-Oriented programming. It is the process of creating a
new Class, called the Derived Class, from the existing class, called the Base Class. Inheritance is a very elegant
way to reuse and modify the data and functionality that has already been defined in the Base Class, also you
can add new data and functionality to the Derived Class. Since the Derived Class inherits all properties of the
Base Class, the Derived Class has a larger set of properties than the Base Class. However, the Derived Class may
override some or all the properties of the Base Class.
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Q.14) What are the advantages of inheritance?
Ans: 1. No need to write code from scratch. You can start coding with existing classes.
2. Through inheritance you can very easily convert small system into large systems
3. You can lots of classes with the same root but have different implementations of classes.
4. Code reusablity through inheritance increased.
5. Good at representing the objects
6. Inheritance provide a clear model structure which is easy to understand without much
complexity.
7. code are easy to manage and divided into parent and child classes.
Share:
Q.15) What is namespace?
Ans: A namespace designates a collection of programming elements, organized and classed for grouping
operations and easy access. At the namespace level, the programming elements include:
• Classes of objects [...];
• Structures [...];
• Modules [...];
• Interfaces [...];
• Delegates [...];
• Enumeration [...];
• Other namespaces.
Q. 16. What is the use of import statement in VB.Net?
Ans: The Imports statement enables types that are contained in a given namespace to be referenced directly.
Imports [ aliasname = ] namespace
-orImports [ aliasname = ] namespace.element

Part - B (Each question carries Three marks) UNIT – III
1.How to create menu bar in VB.Net?
Ans: Menu bar in Visual Basic.net 2008 consist of the commands that are used for constructing a software code.
These commands are listed as menus and sub menus.
Menu bar also includes a simple Toolbar, that lists the commonly used commands as buttons. This Toolbar can be
customized, so that the buttons can be added as required.
2. How to create context menu in VB.Net?
Ans: The ContextMenuStrip control represents a shortcut menu that pops up over controls, usually when you right
click them. They appear in context of some specific controls, so are called context menus. For example, Cut, Copy
or Paste options.
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3. How to create tool bar in VB.Net?
Ans: Either start a new Windows project, or keep the one you currently have. To add a toolbar to the top of your
form, expand the Toolbox and locate the ToolStrip control:

Double click the ToolStrip control, and it will be added to the top of your form:

You should also notice the ToolStrip object that appears at the bottom of the window:

ToolStrips work by adding buttons and images to them. The button is then clicked, and an action performed.
Click on your ToolStrip to select it. In the property box for the ToolStrip, you'll notice that it has the default Name
of ToolStrip1. We'll keep this Name. But locate the Items (Collection) property:
Click the button with the three dots in it. This brings up the Items Collection Editor:
To add a new button to your ToolStrip, click the Add button at the top. The button appears in the Members box
(ToolStripButton1):
Notice that the new button has its own list of properties, just to the right. To add an image to this new button,
locate the Image property:
Click the small button with the 3 dots in it to bring up the Select Resource box:
In the image above, we've selected "Project resource file", and then clicked the Import button. We then navigated
to some Bitmap images and imported the five that you can see in the screenshot above (these are in the BITMAP
folder that you download at the top of this tutorial). Click OK when you have imported some images. You will be
returned to the Item Collection Editor. Click OK on this, as well. The ToolStrip on your form will then look like this:
The second of those images is a dropdown list of available ToolStrip options:
To add a new button to the toolstrip, click on Button from the drop down menu in the image above. A default
button is added called ToolStripButton2. (The first button is called ToolStripButton1.)
To change the picture of the new button, locate the Image property in the properties area bottom right:
Click the button with the three dots in it to bring up the Select Resource dialogue box again. Select Project resource
file from the list, and choose a new icon:
The default button image will then change to the one you selected:
(If you wanted to, you could change the name of the button. Just delete ToolStripButton2 from the Name property
and type a new one.).
Repeat the steps above to add more buttons to the toolstrip. It should then look something like ours:
There is, however, a problem with our toolstrip images: they all have an awful grey background. You can get rid of
background colours on toolstrip images by changing the ImageTransparentColor property.
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Make sure one of your buttons is selected. In the properties area in the bottom right,
locate ImageTransparentColor. The default is Magenta. You can change this. Click inside the Magenta text box and
press the delete key on your keyboard. Change Magenta to the numbers 192, 192, 192. (This is the RGB colour of
our grey background. We got these numbers from image editing software.) Press the Enter key on your keyboard
and these numbers will change to the named colour Silver:
Change all the other colours on your toolstrip from Magenta to Silver. When you run your form again, it should
look like this:

Of course, if you click on the buttons nothing will happen. We need to write the code that gets them to work. We'll
do that now.
4. Give an example of logical errors in VB.Net.
Ans: Dim i As Integer
Dim LetterCount As Integer
Dim strText As String
Dim letter As Char
strText = "Debugging"
For
i = 1 To strText.Length - 1
letter = strText.Substring(1)
If letter = "g" Then
LetterCount = LetterCount + 1
End If
Next
TextBox1.Text = "G appears " & LetterCount & " times"
5. How to set Break Points in VB.Net?
Ans: VB NET Breakpoints
A breakpoint is like a note to VB.NET to stop your programme at a particular place. You add one to your code by
clicking in the margins. A brown circled then appears, indicating where the code will break. The following two
images show how to add one:

Notice that the line where you want VB.NET to break is highlighted brown.
Run your programme, and click the button. You are immediately returned to the coding window. The place where
you put the Breakpoint will now have a yellow arrow on top of the brown circle. The brown highlighted line will
now be yellow:
7. What do you mean by ‘Debugging Using the Watch Window’?
Ans: Watch windows is one of most commonly used debugging tool with Visual Studio. We generally used to
explore the objects, values, properties and other nested objects as a tree structure. Most of the time we used
watch window to only view the values or change the current object properties values to see the effects of changed
object during debugging. But we can use watch windows for many different purposes. In this blog post I am going
to show 10 Tips, that may help you while dealing with Watch Window.
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8. How to create an object in VB.Net? Give an example.
Ans: Objects
A class is just a description of some properties and methods and does not have a life of its own (with the exception
of shared members, which we discuss later). In general, to execute the methods and use the properties of a class,
we must create an instance of the class, officially known as an object. Creating an instance of a class is referred to
as instancing, or instantiating, theclass.
There are three ways to instantiate an object of a VB.NET class. One method is to declare a variable of the class’
type:
Dim APerson As CPerson
and then instantiate the object using the New keyword as follows:
APerson = New CPerson( )
We can combine these two steps as follows:
Dim APerson As New CPerson( )
or:
Dim APerson As CPerson = New CPerson( )
9. How to create a class in VB.Net?
Ans: A class definition starts with the keyword Class followed by the class name; and the class body, ended by the
End Class statement.
Following is the general form of a class definition:
[ <attributelist> ] [ accessmodifier ] [ Shadows ] [ MustInherit | NotInheritable ] [ Partial ] _
Class name [ ( Of typelist ) ]
[ Inherits classname ]
[ Implements interfacenames ]
[ statements ]
End Class
10. What is method overriding?
Ans: When two or more methods (functions) have the exact same method name, return type, number of
parameters, and types of parameters as the method in the parent class is called method Overriding.
class parentClass
{
public virtual void Disp(int i)
{
System.Console.WriteLine("parentClass Display" + i);
}
}
class childClass : parentClass
{
public override void Disp(int i)
{
System.Console.WriteLine("childClass Display" + i);
}
}
11. What do you mean by base class and derived class?
Ans: Base Class - The derived class inherits the base class member variables and member methods. Therefore, the
super class object should be created before the subclass is created. The super class or the base class is implicitly
known as MyBase in VB.Net
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Derived class - A class can be derived from more than one class or interface, which means that it can inherit data
and functions from multiple base classes or interfaces. The syntax used in VB.Net for creating derived classes is as
follows:
<access-specifier> Class <base_class>
...
12. How to create a constructor in VB.Net?
Ans: A class constructor is a special member Sub of a class that is executed whenever we create new objects of that
class. A constructor has the name New and it does not have any return type. Following program explains the
concept of constructor:
Class Line
Private length As Double ' Length of a line
Public Sub New() 'constructor
Console.WriteLine("Object is being created")
End Sub
Public Sub setLength(ByVal len As Double)
length = len
End Sub
Public Function getLength() As Double
Return length
End Function
Shared Sub Main()
Dim line As Line = New Line()
'set line length
line.setLength(6.0)
Console.WriteLine("Length of line : {0}", line.getLength())
Console.ReadKey()
End Sub
End Class
13. Write down any two types of error in VB.Net.
Ans: 1)Syntax Errors
Syntax errors are those that appear while you write code. Visual Basic checks your code as you type it in the Code
Editor window and alerts you if you make a mistake, such as misspelling a word or using a language element
improperly. Syntax errors are the most common type of errors. You can fix them easily in the coding environment
as soon as they occur.
2)Run-Time Errors
Run-time errors are those that appear only after you compile and run your code. These involve code that may
appear to be correct in that it has no syntax errors, but that will not execute. For example, you might correctly
write a line of code to open a file. But if the file is corrupted, the application cannot carry out the Open function,
and it stops running. You can fix most run-time errors by rewriting the faulty code, and then recompiling and
rerunning it.
14) What do you mean by reusability?
Ans: reusability is the use of existing assets in some form within the software product development process;
these assets are products and by-products of the software development life cycle and include code, software
components, test suites, designs and documentation. The opposite concept of reusability is leverage, which
modifies existing assets as needed to meet specific system requirements.
15)Write down the syntax and example of Try – Catch statement.
Ans (for syntax refer mark 2(7))
Example: Module exceptionProg
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Sub division(ByVal num1 As Integer, ByVal num2 As Integer)
Dim result As Integer
Try
result = num1 \ num2
Catch e As DivideByZeroException
Console.WriteLine("Exception caught: {0}", e)
Finally
Console.WriteLine("Result: {0}", result)
End Try
End Sub
Sub Main()
division(25, 0)
Console.ReadKey()
End Sub
End Module

Part - C (Each question carries Five marks) UNIT – III
1. How to set Check Marks and Radio checks in menu bar in VB.Net.
Ans . The CheckBox control allows the user to set true/false or yes/no type options. The user can select or deselect
it. When a check box is selected it has the value True, and when it is cleared, it holds the value False.
Let's create two check boxes by dragging CheckBox controls from the Toolbox and dropping on the form.

The CheckBox control has three states, checked, unchecked and indeterminate. In the indeterminate state, the
check box is grayed out. To enable the indeterminate state, the ThreeState property of the check box is set to
be True.
2. Create a context menu and perform action on mouse click in VB.Net.
Ans.
1. MouseUp Event Routine:
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What kind of events are you firing and what will you be doing with ContextMenu control? As you can see from the
code in the next section, you can determine which item was clicked by casting the "sender" variable to
a MenuItem and querying the Text property. You can use that value to pass to another function or do something
with it.
Write a routine on the “MouseUp” event on your control. This will happen if the right mouse button was clicked
and released; display the context menu assigned to the listView1 or TextBox1 control.
Hide Copy Code
Private Sub listView1_MouseUp(Byval Sender as Object, _
Byval e As System.Windows.Forms.MouseEventArgs) _
Handles listView1.MouseUp
'Checking the Mouse right Button
If e.Button = MouseButtons.Right Then
ContextHandler(listView1,e)
listView1.ContextMenu.Show(listView1, New Point(e.X,e.Y))
End if
End sub
Private Sub TextBox1_MouseUp(Byval Sender as Object, _
Byval e As System.Windows.Forms.MouseEventArgs) _
Handles TextBox1.MouseUp
'Checking the Mouse right Button
If e.Button = MouseButtons.Right Then
ContextHandler(TextBox1,e)
TextBox1.ContextMenu.Show(TextBox1, New Point(e.X,e.Y))
End if
End sub
3. Explain various types of error in VB.Net.
Ans:- 1)Syntax Errors
Syntax errors are those that appear while you write code. Visual Basic checks your code as you type it in the Code
Editor window and alerts you if you make a mistake, such as misspelling a word or using a language element
improperly. Syntax errors are the most common type of errors. You can fix them easily in the coding environment
as soon as they occur.
2)Run-Time Errors
Run-time errors are those that appear only after you compile and run your code. These involve code that may
appear to be correct in that it has no syntax errors, but that will not execute. For example, you might correctly
write a line of code to open a file. But if the file is corrupted, the application cannot carry out the Open function,
and it stops running. You can fix most run-time errors by rewriting the faulty code, and then recompiling and
rerunning it.
3) Logical Error:4. Write a note on ‘Debugging with the Locals Window’.
Ans.
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5. What do you mean by encapsulation? Explain.
Ans. encapsulation is used to refer to one of two related but distinct notions, and sometimes to the combination
there of:
• A language mechanism for restricting direct access to some of the object's components.
• A language construct that facilitates the bundling of data with the methods (or other functions) operating on
that data.
Contents
1. General definition
2. An information-hiding mechanism
3. Encapsulation and Inheritance
4. References

6. What is class? Explain with a suitable example.
Ans:- Class Definition
A class definition starts with the keyword Class followed by the class name; and the class body, ended by the End
Class statement. Following is the general form of a class definition −
•

attributelist is a list of attributes that apply to the class. Optional.

•

accessmodifier defines the access levels of the class, it has values as - Public, Protected, Friend, Protected
Friend and Private. Optional.

•

Shadows indicate that the variable re-declares and hides an identically named element, or set of overloaded
elements, in a base class. Optional.

•

MustInherit specifies that the class can be used only as a base class and that you cannot create an object
directly from it, i.e., an abstract class. Optional.

•

NotInheritable specifies that the class cannot be used as a base class.

•

Partial indicates a partial definition of the class.

•

Inherits specifies the base class it is inheriting from.

•

Implements specifies the interfaces the class is inheriting from.

7. Explain constructor in details.
Ans:- What is constructor?
A special method of the class that will be automatically invoked when an instance of the class is created is called a
constructor. The main use of constructors is to initialize private fields of the class while creating an instance for the
class. When you have not created a constructor in the class, the compiler will automatically create a default
constructor in the class. The default constructor initializes all numeric fields in the class to zero and
all string and object fields to null.
Some of the key points regarding the Constructor are:
• A class can have any number of constructors.
• A constructor doesn't have any return type, not even void.
• A static constructor can not be a parametrized constructor.
• Within a class you can create only one static constructor.
Constructors can be divided into 5 types:
1. Default Constructor
2. Parametrized Constructor
3. Copy Constructor
4. Static Constructor
5. Private Constructor
Now let us see each constructor type with example as below
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Default Constructor
A constructor without any parameters is called a default constructor; in other words this type of constructor does
not take parameters. The drawback of a default constructor is that every instance of the class will be initialized to
the same values and it is not possible to initialize each instance of the class to different values. The default
constructor initializes:
1. All numeric fields in the class to zero.
2. All string and object fields to null.
8. Differentiate menu and context menu in VB.Net.
Ans:- Ref. Q. No. 1 in 10 Marks

9. Write a note on ‘Reusability’.
Ans:- reusability is the use of existing assets in some form within the software product development process;
these assets are products and by-products of the software development life cycle and include code, software
components, test suites, designs and documentation. The opposite concept of reusability is leverage, which
modifies existing assets as needed to meet specific system requirements.
Software reusability more specifically refers to design features of a software element (or collection of software
elements) that enhance its suitability for reuse.
Consensus has not yet been reached on this list on the relative importance of the entries nor on the issues which
make each one important for a particular class of applications.
10. Explain debugging techniques in detail.
Ans:- Debugging is efficient if it detects all program errors in a short time. This paper discusses several techniques
for improving debugging efficiency. Attention is given both to the initial debugging and to acceptance testing in the
maintenance stage. A main decision is whether to use top-down or bottom-up debugging, and it is suggested that
top-down debugging is more efficient if Combined with some of the other techniques. All the techniques shown
are independent of any particular language or debug software.
TOP-DOWN DEBUGGING VERSUS BOTTOM-UP In bottom-up debugging, each program module is tested separately
in special test surroundings (module testing). Later, the modules are put together and tested as a whole (system
testing). In top-down debugging, the entire program is always tested as a whole in nearly the final form. The
program tested differs from the final form in two ways:
1. At carefully selected places, output statements are inserted to print intermediate values (test output).
2. Program parts which are not yet developed are absent or replaced by dummy versions. With this technique, test
data has the same form as input for the final program.
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Part - C (Each question carries Ten marks)
1. Explain menu and context menu in details.
Ans:- The Context Menu control provides functionality of context menus in Visual Studio 2010 and .NET 4.0. A
context menu is also known as a popup menu. A context menu appears when you right click on a Form or on a
control.
In the previous versions of .NET, the context menu functionality was provided by the Context Menu control. In .NET
4.0, the Context Menu control is replaced with the Context Menu control.
In this article, we will discuss how to build context menu enabled Windows applications using Context Menu
control in Visual Studio 2010.
Creating a Context Menu
To create a Context Menu control at design-time, you simply drag and drop a Context Menu control from Toolbox
onto a Form in Visual Studio. After you drag and drop a Context Menu on a Form, the ContextMenuStrip1 is added
to the Form and looks like Figure 1. Once a Context Menu is on the Form, you can add menu items and set its
properties and events. If you noticed in Figure 1, first item of the Context Menu has text Type Here. You can
actually start typing here.

Figure 1
If you notice in Figure 2, I type couple of menu items. As soon as you select a menu item, you will see automatically
sub menu items areas are editable and you can keep going as many levels you like. I add two menu items and two
sub menu items.

Figure 2
We can also create context menus at run-time. Even though you can create a ContextMenuStrip at run-time, it is
recommended you create at design-time and then set the properties and methods at run-time.
First step to create a dynamic ContextMenuStrip is to create an instance of ContextMenuStrip class. The following
code snippet creates a ContextMenuStrip control object.
2. What is an error? Explain various types of error available in VB.Net.
Ans:- Syntax Errors
Syntax errors are those that appear while you write code. Visual Basic checks your code as you type it in the Code
Editor window and alerts you if you make a mistake, such as misspelling a word or using a language element
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improperly. Syntax errors are the most common type of errors. You can fix them easily in the coding environment
as soon as they occur.
Run-Time Errors
Run-time errors are those that appear only after you compile and run your code. These involve code that may
appear to be correct in that it has no syntax errors, but that will not execute. For example, you might correctly
write a line of code to open a file. But if the file is corrupted, the application cannot carry out the Open function,
and it stops running. You can fix most run-time errors by rewriting the faulty code, and then recompiling and
rerunning it.
Logic Errors
Logic errors are those that appear once the application is in use. They are most often unwanted or unexpected
results in response to user actions. For example, a mistyped key or other outside influence might cause your
application to stop working within expected parameters, or altogether. Logic errors are generally the hardest type
to fix, since it is not always clear where they originate.
3. Explain debugging in detail.
Ans:Debugging for embedded systems[edit]
In contrast to the general purpose computer software design environment, a primary characteristic of embedded
environments is the sheer number of different platforms available to the developers (CPU architectures, vendors,
operating systems and their variants). Embedded systems are, by definition, not general-purpose designs: they are
typically developed for a single task (or small range of tasks), and the platform is chosen specifically to optimize
that application. Not only does this fact make life tough for embedded system developers, it also makes debugging
and testing of these systems harder as well, since different debugging tools are needed for different platforms.
Despite the challenge of heterogeneity mentioned above, some debuggers have been developed commercially as
well as research prototypes. Examples of commercial solutions come from Green Hills Software and Microchip's
MPLAB-ICD (for in-circuit debugger). Two examples of research prototype tools are Aveksha and Flocklab. They all
leverage a functionality available on low-cost embedded processors, an On-Chip Debug Module (OCDM), whose
signals are exposed through a standard JTAG interface. They are benchmarked based on how much change to the
application is needed and the rate of events that they can keep up with.
Anti-debugging[edit]
Anti-debugging is "the implementation of one or more techniques within computer code that hinders attempts
at reverse engineering or debugging a target process".[16] It is actively used by recognized publishers in copyprotection schemas, but is also used by malware to complicate its detection and elimination.[17] Techniques used in
anti-debugging include:
• API-based: check for the existence of a debugger using system information
• Exception-based: check to see if exceptions are interfered with
• Process and thread blocks: check whether process and thread blocks have been manipulated
• Modified code: check for code modifications made by a debugger handling software breakpoints
• Hardware- and register-based: check for hardware breakpoints and CPU registers
• Timing and latency: check the time taken for the execution of instructions
• Detecting and penalizing debugger

4. What is inheritance? Write a program in VB.Net to demonstrate the concept of inheritance.
Ans:Inheritance is the idea that one class, called a subclass, can be based on another class, called a base class.
Inheritance provides a mechanism for creating hierarchies of objects. For example, a dog is a mammal and a collie
is a dog. Thus the dog class inherits the properties and methods of the mammalclass, and the collie class inherits
from both dog and mammal.
The objects in a hierarchy have two different types of relationships to one another, referred to in object-oriented
parlance as HasA and IsA relationships. For example, a Collie IsA dog and HasA tail. Implementation inheritance is
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the object-oriented feature that supports IsA relationships. Containment supports HasA relationships.
Implementation inheritance is also another way that VB.NET supports polymorphism. A function might accept a
parameter typed as mammal and then an object that is derived from mammal can be passed in as the parameter.

Public Class Person
Protected c_sFirstName as String
Protected c_sLastName as String
MustOverride ReadOnly Property ClassName() as String
Get
ClassName = "Person"
End Get
End Property
NotOverridable ReadOnly Property BaseClassName() as String
Get
BaseClassName = "Person"
End Get
End Property
Overidable Public Property FirstName() as String
Get
FirstName = c_sFirstName
End Get
Set(ByVal Value as string)
c_sFirstName = Value
End Set
End Property
Overidable Public Property LastName() as String
Get
LastName = c_sLastName
End Get
Set(ByVal Value as string)
c_sLastName = Value
End Set
End Property
Overridable Sub Speak()
Console.WriteLine("I am " & c_sFirstName & " " & c_sLastName)
Console.WriteLine(" and I am a Person.")
End Sub
End Class

5. Write a Windows application using Context Menu to Cut, Copy, Paste Text using Rich Text Box Control.
Ans:-
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UNIT 4 (2 Marks Question)
Q. 1) Define database?
Ans : A database is a collection of information that is organized so that it can be easily accessed, managed and
updated. Data is organized into rows, columns and tables, and it is indexed to make it easier to find relevant
information.
Q. 2) What is table?
Ans : A table is a collection of related data held in a structured format within a database. It consists of columns, and
rows.
Q. 3) What do you mean by query?
Ans : A query is a question, often expressed in a formal way. A database query can be either a select query or an
action query. A select query is a data retrieval query, while an action query asks for additional operations on the data,
such as insertion, updating or deletion.
Q. 4) What is dataset?
Ans : Datasets store data in a disconnected cache and the application retrieves data from it.
Q.5) What is the purpose of OleDBconnection?
Ans : Initializes a new instance of the OleDbConnection class.
Initializes a new instance of the OleDbConnection class with the specified connection string.
Q. 6) What is the purpose of OleDBCommand?
Ans : creates an OleDbCommand and then executes it using ExecuteNonQuery. The example is passed a string that
is an SQL statement.
Q.7) What do you mean by data binding?
Ans : Data binding, in the context of .NET, is the method by which controls on a user interface (UI) of a client
application are configured to fetch from, or update data into, a data source, such as a database or XML document.
Prior to .NET, access to data binding models was limited to databases.
Q. 8) What is ADO.NET?
Ans : Microsoft ActiveX Data Objects.Net (ADO.Net) is a model, a part of the .Net framework that is used by the .Net
applications for retrieving, accessing and updating data. ADO.Net object model is nothing but the structured process
flow through various components.
Q.9) What is the purpose of sqlconnection Class?
Ans : Initializes a new instance of the sqlconnection class.
Initializes a new instance of the sqlconnection class with the specified connection string.
Q.10) What is the purpose of sqldataadaptor class?
Ans : sqldataadaptor can be considered as a collection of command object which act like an interface and bridge
between database and dataset for transferring the data.
Q. 11) What is deployment?
Ans : Deploying from Visual Studio using VB.NET. ... Visual Studio .NET provides you the ability to deploy your
applications easily. If you click File->Add Project->New Project, that brings up the template dialog in which you can
create a deployment project.
Q. 12) What is XCOPY Deployment?
Ans : XCOPY deployment or xcopy installation is a software application's installation into a Microsoft Windows system
simply by copying files. The name is derived from the XCOPY command line facility provided by Microsoft operating
systems.
Q. 13) What are the use of bootstrap Loader?
Ans : Bootstrap loader. Alternatively referred to as bootstrapping, bootloader, or boot program, a bootstrap loader
is a program that resides in the computer's EPROM, ROM, or other non-volatile memory. It is automatically executed
by the processor when turning on the computer.
Q. 14) What do you mean by Private Assemblies?
Ans : Per definition, A private assembly is normally used by a single application, and is stored in the application's
directory, or a sub-directory beneath. and A shared assembly is normally stored in the global assembly cache, which
is a repository of assemblies maintained by the .NET runtime.
Q. 15) What do you mean by ‘Deploying’ a web application ?
Ans : web.xml ( Web Application Deployment Descriptor) File which contains information about the web application.
Directory which contains classes which are used in the web application (e.g., beans and servlets). This classes are
organized into directories according to their package structure.
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Unit 4 - 3 Mark Question
Q.1) Explain select statement in sql.
Ans : Select (SQL) The SQL SELECT statement returns a result set of records from one or more tables. A SELECT
statement retrieves zero or more rows from one or more database tables or database views. In most applications,
SELECT is the most commonly used data query language (DQL) command.
Q.2) What is the purpose of OleDbDataAdapter class?
Ans : Represents a set of data commands and a database connection that are used to fill the DataSet and update the
data source.
Q.3) What is the purpose of Dataview in VB.Net?
Ans : The final common technique used to work with a DataSet is to display its data using a DataView. Simply put, a
DataView object is a view of a particular DataTable within a DataSet that can expose the data in a particular sort
order or can filter the data
Q.4) What is the meaning of DataGrid Control?
Ans : A data grid is a set of structured services that provides multiple services like the ability to access, alter and
transfer very large amounts of geographically separated data, especially for research and collaboration purposes.
Q.5) What is the purpose of Data source property?
Ans : DataSource property lets you bind to objects that inherit the base abstract SchedulerDataSource class. The
SchedulerBindingDataSource implementation of scheduler data source binds traditional data stores like lists of
business objects and database tables. You can find the SchedulerBindingDataSource component in the Toolbox.
The SchedulerBindingDataSource class has two properties: EventProvider and ResourceProvider that correspond to
the provider instances of type EventBindingProvider and ResourceBindingProvider.
Q.6) Write down the syntax and example of binding controls ?
Ans :
Dim WithEvents oBinding As Binding
Private Sub Form2_Load(ByVal sender As Object, ByVal e As System.EventArgs) _<BR>

Handles MyBase.Load

oBinding = New Binding("Text", oDt, "GetDateTime")
txt1.DataBindings.Add(oBinding)
<BR
txt2.DataBindings.Add("Text", oDt, "GetDateTime")
End Sub
Private Sub oBinding_Format(ByVal sender As Object, ByVal e <BR>
System.Windows.Forms.ConvertEventArgs) Handles oBinding.Format
e.Value = Format(e.Value, "MM/dd/yy")
End Sub

As

Q.7) What do you mean by No Touch Deployment?
Ans : The Microsoft .NET Framework gives you the ability to deploy applications from a Web or file server. This
technique, called "no-touch deployment", combines the performance and interactivity of a smart client application
with all the deployment advantages of a Web application. To deploy your application over the Web, right-click the
folder that contains your executable and select Properties. On the Web Sharing tab, select Share this folder. Enter
an alias for the folder.
Q.8) How do creating a setup application for paint?
Ans :
Q.9) What do you mean by shared Assemblies ?
Ans : Assembly in VB.NET. It is the unit of deployment for the Microsoft .NET framework and takes the form of an
executable (.exe) file or dynamic-link library (DLL). Assembly is logical unit of code. All the .NET assemblies contain
the definition of types, versioning information for the type, meta-data, and manifest
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Q. 10) What do you mean by ‘Deploying Desktop Applications?
Ans : Applications developed for the desktop are installed like any other Microsoft Windows application. You can
deploy Windows-based applications from Visual Studio by using either of the following technologies: ClickOnce or
Windows Installer. For more information about deploying applications from Visual Studio, see the Visual Studio 2010
documentation. Your application can be built to use either central or private deployment for SQL Server Compact
4.0; for more information, see Private Deployment vs. Central Deployment (SQL Server Compact).
Q.11) Write any three data Access components in VB.Net.
Ans SqlConnection
OleDbConnection
OdbcConnection
Q.12) Write a note on system.data namespace.
Ans : The System.Data namespace provides access to classes that represent the ADO.NET architecture. ADO.NET lets
you build components that efficiently manage data from multiple data sources.
These interfaces are defined in the System.Data namespace. For example, SqlConnection, OleDbConnection, and
OdbcConnection classes are derived from IDbConnection interface. Similar to the connection classes, other ADO.NET
components such as DataAdapter, DataReader, Command also implement their relative interfaces

Unit 4 – 5 Marks Question
Q. 1) Explain any two data access components in VB.Net.
Ans : SQLInstancesFinder
This class provides static functionalities to query SQL Server instances available over a network. Each SQL Server
instance is represented using the SQLInstancesFinder.SQLServerInstance class, which contains the name and
version information of that instance. Additional functionalities are there which retrieve the name of databases in a
particular server using Windows/SQL authentication.
ODBCDataSourcesFinder
This class provides the static functionalities to query the ODBC data sources (System/User/File) configured in a
computer. Each source is represented using the ODBCDataSourcesFinder.ODBCDataSource class, which contains
the name and driver information of that data source.
Q.2) Explain ADO.Net data Namespace in details.
Ans : ADO.NET provides a bridge between the front end controls and the back end database. The ADO.NET objects
encapsulate all the data access operations and the controls interact with these objects to display data, thus hiding
the details of movement of data.
The following figure shows the ADO.NET objects at a glance:
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The DataSet Class
The dataset represents a subset of the database. It does not have a continuous connection to the database. To
update the database a reconnection is required. The DataSet contains DataTable objects and DataRelation objects.
The DataRelation objects represent the relationship between two tables.
Q.3) What is the purpose of executeNonQuery method? Explain.
Ans : ExecuteNonQuery used for executing queries that does not return any data. It is used to execute the sql
statements like update, insert, delete etc. ExecuteNonQuery executes the command and returns the number of
rows affected.
Dim retValue As Integer
Command = New SqlCommand(Sql, Connection)
retValue = Command.ExecuteNonQuery()
Q.4) How to set select command to a stored procedure in VB.NET? Explain
Ans : Enter the SQL SELECT statement.
When you click Next, the Data Adapter Configuration Wizard uses the SQL SELECT
statement you entered to generate other SQL statements that insert, update, and
delete records. shows the Wizard's results screen.

Q.5) Explain different Binding controls in details
Ans : Visual Basic .NET does things the same way, only different. You can still bind
controls to data at design time or at runtime. The objects and methods you use are
different, however.
The basic plan is to do the following :
1. Make a database connection.
2. Make a data adapter to move data in and out of the database.
3. Make a DataSet to hold the data.
4. Bind the DataSet to controls.
5. Write code to load and save the data.
The next several sections explain how to perform these steps at design time. The sections that follow explain how
to perform the same steps at runtime.
The examples described here use OLE DB objects to connect to an Access database. You can just as easily use SQL
Server objects to connect to a SQL Server database by replacing the OLE DB objects with the corresponding SQL
Server objects. For example, instead of using an OleDbConnection object to connect to the database, the program
would use a SqlConnection object.
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Q.6) Explain no touch deployment and XCOPY deployment in details
Q.7) Write down the steps to create a Visual Studio.Net Setup application.
Q.8) Write a note on Assemblies.
Ans : It is the unit of deployment for the Microsoft .NET framework and takes the form of an executable (.exe) file or
dynamic-link library (DLL). Assembly is logical unit of code. All the .NET assemblies contain the definition of types,
versioning information for the type, meta-data, and manifest. Assemblies are a collection of Single-File and MultipleFile. An assembly is the primary unit of deployment, security, and version control in the .NET Framework. The .NET
Framework (version 2.0) includes 51 assemblies.
Before we can use a class contained in an assembly in our application, we must add a reference to the assembly.
mscorlib.dll
System.dll
System.Configuration.dll
System.Web.dll
System.Data.dll
System.Web.Services.dll
System.Xml.dll
There are two types of assemblies:
• Private:
A
private
assembly
can
be
used
by
only
a
single
application.
•

Shared: A shared assembly can be used by all applications located on the same server.(also called strong
named assemblies) are copied to a single location (usually the Global assembly cache) GAC.
Advantages of using assemblies
1.It increase the overall Performance
2.It can use the N-tier Architecture
3.Used for business Logic
4.Better user interaction
5.Easy to manage the code
Q.9) Explain the core of deployment using a bootstrap Loader.
Q.10) Write a note on OleDbCommand and OleDbDataReader in Vb.Net.
Ans : Represents an SQL statement or stored procedure to execute against a data source.
When an instance of OleDbCommand is created, the read/write properties are set to their initial values. For a list of
these values, see the OleDbCommand constructor.
OldDBDataReader : Provides a way of reading a forward-only stream of data rows from a data source. This class
cannot be inherited.
public sealed class OleDbDataReader : System.Data.Common.DbDataReader
To create an OleDbDataReader, you must call the ExecuteReader method of the OleDbCommand object, instead of
directly using a constructor.
Before you close the OleDbConnection, first close the OleDbDataReader object. You must also close the
OleDbDataReader object if you plan to resuse an OleDbCommand object.For example, you cannot retrieve output
parameters until after you call Close.
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